12.2 Sorting Music

Music files at large capacity hard drive need to be sorted since it's easy to organize and
search. TizzBird provides various “SORTING” functions based on the powerful Android
database. Press GREEN color button on remote to sort by ALBUM, ARTIST, TITLE or YEAR.
The following two images show SORT BY GENRE and SORT BY YEAR.

SORT BY GENRE SORT BY YEAR

12.3 Music Playback Screen

Select album art to playback the selected music. The following image will appear.
Left pane: Shows album-art image, current playback status and position.
Right pane:  Shows list of songs, song information and album-art thumbnail.

Press <UP> or <DOWN> arrow key to browse songs and press <OK> to start playback.
Now playing music will be shown in YELLOW and selected music in LIGHT GREEN color.
Press <PREV> or <NEXT> button to turn pages, if there are more pages on the song list,

. 3
ARTIST PLAYLIST
1. Stayin’ Alive
2. Fame
3. Gimme! Gimme! Gimme!
4. Ring My Bell
5. Funkytown
6. That Night

7. Can't Take My Eyes off You
8. Cherlsh You

9. Rock with You

10. Could It Be Magic

11, Dream

12. Fantasy

12.4 Music Playback Menu

Available button when playback music is like this:
<PLAY/PAUSE> button: play or pause the music
<UP> or <DOWN> button: skip playback position designated at settings.
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13 Watching Photo
13.1 Photo Browser

The following PHOTO BROWSER screen will appear when selecting PHOTO BROWSER. It's
composed of superb folder thumbnails COVER-VIEW which is quite neat and intuitive. Each
image shows thumbnails of photos that folder contains.

13.2 Photo Browsing Menu

Press <MENU> button to bring quick <SEARCH FOLDER> function.

13.3 Photo Wall

The following screen will appear after selecting one of the folder thumbnails. Photo wall can
be used to select one of photos. Use arrow buttons to navigate the photos and press <OK>
button to see the photo at full screen.
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13.4 Photo Playback Screen

Photo slide show will start automatically, so next photos will keep appearing with transition
effect. The various TRANSITION EFFECTS can be configured at <SETTINGS BROWSER> -
<PHOTO>.

13.5 Slideshow Control

Slideshow can be controlled by arrow and <PLAY/PAUSE> buttons. Press <PLAY/PAUSE>
button to pause or resume to playback. Use arrow keys to change the slide direction.
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14

Posters, Album Art and Photo Arrangements

The arrangement of each browser and shape of each item can be configured at each
browser. For example, you can change the number of items of movie browsers and shape of
posters.

Press <Menu> button on the remote at Movie Browser. The <Movie Settings> Menu was
added to configure the movie browser directly. This will bring the <Settings Browsers> >
<Movie> directly.

You can configure the movie posters arrangements and shape of posters.

Press <Menu> button on the remote at Movie Browser. The <Movie Settings> Menu was
added to configure the movie browser directly. This will bring the <Settings Browsers> >
<Movie> at movie browser.

*  MOVIE

Browser Mode
Browser Item Mode

| Advanced Setting

PAGE 2/2

There are new setting items at PAGE2 of movie settings like above screen, which are <Browser
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Mode> and <Browser Item Mode>. You can configure layouts of browsers at <Browser Mode> and
configure shape of each item at <Browser Shape Mode>.

For example, the <Browser Item Mode> will bring you the following screen to configure the border
type, border alpha value, width, radius and item alpha. Alpha is transparency rate.

For example, configure 8x3, rounded border and border width 3 will give you something like this
movie browser.

TTRTE T i

/[HD] & AFE| &(Om Shanti Om, 2007)
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This kind of configuration is also possible at MUSIC and PHOTO BROWSER. Please notice the
following screen-shots.

MUSIC

yterval

' Browser Mode

8x4
v6x3

PAGE 1/1

Browser Item Mode

PAGE 1/1
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For example, configure 6x3, rounded border and border width 3 will give you something like this
music browser.

Pim |
1la &

uis

hak o Womderful Dust |

BILL FVANS

-’
I‘:f

4

Here’s the photo setting:
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Transition Effect
Slideshow Interval
Slideshow Mode
Device Type

Sort Type

Order Type

< il

Browser Mode
Browser Item Mode Rounded White Border

Wallpaper Mode

PAGE 1/2
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For example, configure 7x3, rounded border and border width 3 will give you something like this
photo browser.

/100 hq wallpapers
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15 Using File Browser

15.1

File Browser Screen

The following screen will appear when selecting FILE BROWSER. This is quite similar
browser user interface that legacy media players provided before. Folder or file based
browsing is possible on this browser, and selecting and playback the file directly.

The left pane is FOLDER PANE, and the right pane is FILE PANE.

L
|
=i
L=t
=}
=
L=}
=
s
=

HDD/Demo Reference/Movie
[Up folder]
[Current folder]
Avatar
Gladiator 10th Anniversary Edition 2000
Inception
Perfect Storm
Salt
The Dark Knight
2ic) g (Legend Of The Guardians
Cj op * (The Other Guys, 2010)

FILE LIST
& casino Royal

Folders can be browsed by arrow keys and press <OK> button to select that folder. The
files will be appeared on the right pane if that folder contains the files. The GREEN outline
on the pane means it's selected. Press <RIGHT> arrow button to move the FILE PANE and
select the file. Press <OK> to select and start playback that file.

L
L

HDD/movie/PVR
[¥12)
MBC DTV

oy =

&5 [L174] 11-06-05(% ) [HD)
(L1714 11-06-19(3 ) [HD]
& [4719] 11-06-26(%) [HD] T2/ B2 Yiktp
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15.2 Selecting Device at File Browser

External USB, internal HDD storage device, or network drive can be selected at FILE
BROWSER. Press <RED> button on the remote and the device drop-down list will pop-up
like following image. Use <UP> or <DOWN> arrow key to browse devices. Choose one of
them then press <OK> to select it.

FILE LIST

HDD/Demo Reference/Movie

[Up folder]

% casino Royal

[Current folder]

Avatar

Gladiator 10th Anniversary Edition 2000

Inception

Perfect Storm

Salt

The Dark Knight

7HE] # (Legend Of The Guardians.
)| 2 (The Other Guys, 2010)

sgssgERERY

>

PAGE

15.3 Register Subtitle Font File

Subtitle font file can be selected at file browser. Copy or move the font file (true-type font
file - .TTF extension) to the USB drive or internal HDD from PC, then connect the drive to
TizzBird. Press <RED> button to select drive and navigate into the folder that font file was
copied. The font file will appear like the following image.

Select one of the font file and press <OK> button to register. Several font files can be
registered at once.

FILE LIST

s H2ZMKPB.TTF

[Current folder]
APKs

H2PORL.TTF
ChineseAndroidGame H2PORM.TTF
Fonts HGHANGSO.TTF

Install

SESREET

Localization

W as+sEA-R

A E

Registered font files will appear at movie playback screen menu. Press <MENU> button and
choose <SUBTITLE> icon.
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15.4 Using File Operation

Rev 1.12 firmware provides the “File Operation” capability which enables COPY, MOVE,
DELETE, RENAME and NEW FOLDER functions. Press "MENU” button on the remote then
select the “File Operation” ICON at the pop-up window to enter this mode.

SRECYCLE.BIN oD
SRECYCLE.BIN

.gomarket
.gomarket

.volume
Android
BT

~volume
Android
BT

Font
ms
LOST.DIR

Font
IMS

LOST.DIR
mnt

mnt
movie

movie
Available Space

4

The left pane is source window and the right pane is target window. The “File Operation
will function from left pane to right pane. The following remote buttons can be used.

OK

OK button > Browse and enter the folder.
Bookmark button > Select the item to operate.
E Menu button > Pop-up the FILE OPERATING ICONs.

Please use left or right arrow button to move left or right pane. The RED button can be
used to select the device at each pane. This RED button enables the selection of source or
target device at each pane.
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Pressing BOOKMARK button will check the selected item like below picture. The check icon
will appear on the small box at left side of item.

HDD/movie
= [up folder)
[BD] ¥ 2(Ip Man)
[HD] ! £0}E(Get Smart, 2008 VC-1)
[HD] 2L O{ % O|(The Getaway, 1994)
[HD] Lt AtEH(Bad Santa, 2003)
[HD] & & (The Cell, 2000)
[HD] 2{ £ O E& A(Love and other drugs, 2010)
[HD] Bo| L4 2| E| 2| & E(Minority Report, 2002)
[HD] O}O|OHA| H}O| A(Miami.Vice, 2006)
[HD] & Ata|OMamma Mia, 2008)

U
[
[
[
[
U
U
U

Item Size 9.30G

The total size of selected item will be also calculated whenever BOOKMARK button is
pressed. It will take some time if there are many items at selected folder.

Pressing MENU button will bring the following POP-UP menu to select the function. The
COPY, MOVE, DELETE, SELECT ALL, CANCEL, RENAME, NEW FOLDER can be selected.

The COPY or MOVE operation will be performed always from LEFT PANE to RIGHT PANE.
The DELETE, RENAME, SELECT ALL and CANCEL will be performed always at LEFT PANE.
The NVEW FOLDER will be performed on selected pane. Please select the wanted icon to
execute the operation.
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16 Connecting Internet

16.1 Execute Internet Browser

Web browser will appear if WEB BROWSER was selected at HOME SCREEN and network
was connected like following image.

X Using mouse is highly recommended at WEB BROWSING. Wireless RF or USB
mouse can be used. Web address or other information can be entered thru virtual
keyboard with mouse. Wanted article or link can be clicked with mouse as well.

[@http:/tkr.yahoo.com/?p=us 0 18 <
YAHQEO’ | B Uy

Q « S T 270008 2 ) vae i Sreutn HasY

a2 s v ?“ ¥ I '.I v I “. _.I.:..r. I,‘". 3. 0 Aol B I ' \ -..-. :
@« e TR e

(= BT N SELINTE B -8-1 T W O Rd WY

i 1y mmn W M (21 OF A
l . m S EH 2 "

16.2 Control Internet Browser

Press <BACK> button on remote or click mouse right button to move back to the previous
screen. Press <MENU> button on the remote to change the home page and register at
there.

| http://kr.yahoo.co

OpRL! B 2|0}
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17 Install and Execute Application
17.1 Move applications at Android Phone to TizzBird

The applications on the Android smart phone can be installed on this unit. The procedures
are like this.

1) Download or move the applications on the Android smart phone at USB flash drive.

- Move the applications on the smart phone to SD card. This can be done by
Android application like “App Monster”. This kind of application let user backup
their APP to SD card.

- Move the APP at SD card to USB flash drive. Attach the USB flash drive to the
unit.

- Run FILE BROWSER at HOME SCREEN, and select the application that you
want to install.

(" )

The APP at smart phone may have problems when installing or executing since it
requires GPS, PHONE or TOUCH function. Or it always shows in portrait mode, since the
application is just intended to use on phone.

X Some APP requires specially touch function. In this case, mouse should be used. So
using mouse is highly recommended when running applications.

\ J

17.2 Execute Application

The following image will appear when running APP BROWSER at home screen.

) APPLICATION LIST

GoMarket QQEk

ds| Drowser DVDLIVE Gallery

Sl 2

rURRORLY
Search settings  TurboFly 30 M ER0l. WRFFTH

PAGE 1/1

Use arrow buttons to browse the application and press <OK> button to execute it.
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18 Settings

Various set-ups can be configured at SETTINGS BROWSER.

18.1 System

Menu language, date & time, system information, firmware information and update can be
set-up at this menu.

Language

Time & Weather

System Information

er TimeQut
ode
er Off Time

Screen Resize

Time & Weather

Language > Select menu language. Press <OK> to bring the pop-up.
Time & Weather - Set up the time & weather location, manually or automatically.

Network should be configured and connected to get time &
weather location automatically.

System Information >  Show current system information like firmware version.
Firmware Update > Update the firmware.

Load Default Settings > Clear the previous settings and get back to the default settings
Screen Saver Time-Out - Set up the screen saver time-out.

Screen Saver Mode > Configure the screen saver icon or off the saver.

Auto Power Off Time >  Configure automatic power off time

Screen Resize > Configure the size of graphic user interface screen.

TizzRemote Setting > Setup the TizzRemote by QR code and setup the System name
for TizzRemote searching.

Next page contains more system settings.
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TizzRemote Setting
External Keyboard Layout

System Theme

Advanced Setting

TizzRemote Setting

TizzRemote Setting > Setup the TizzRemote by QR code and setup the System name
for TizzRemote searching.
TizzRemote Setting

TizzZRemote Install QR code
System name for TizzRemote

PAGE 1/1

The TizzRemote™ is the remote application for TizzBird which can replace keyboard, mouse
and keyboard.

There are two methods to install the TizzZRemote™. The TizzRemote™ itself is already on
the Google Market, so you can directly download it at your smart phone. The other way is
using the QR code. If you select the above item at the dialog box, the following dialog box
will pop-up.

TizzRemote Setting

Using QR code scanner to recognize the following QR
code, you can install TizzRemote on your phone. QR
code scanner is available from the App Store.

If you have QR code scanner on your smart phone, then scan this QR code with it, the
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TizzRemote™ APP will be automatically download and installed on your smart phone.

External Kbd Layout >  Select between QWERTY or AZERTY type key board.

System Theme > Select launcher between TizzBird theme and Android theme

=

System Theme

Pop-up
v Android Launcher
TizzBird Launcher

PAGE 1/1

Advanced Setting > Show advanced (not for casual use) setting.

el b NS 0§ W A

Advanced Setting

Device Scanning « Always
Scanning Filename D.. Off
Power Button Suspend

Disk Format
OTG Port Mode Host
Set Factory Default

PAGE 1/1

Device Scanning > Select between scanning device “Always”, “New Device Only” and
“Never”. It will determine the scanner for database will be applied
always or new device only or never.

Scanning Filename Display > It will determine display file name during device
scanning or not.

Power Button -> Select between “Power Off” and “Suspend” when pressing power
button. If “Power Off” selected, the system will completely be
powered off when POWER button pressed. System will boot up
completely from initial stage when next POWER-ON. (COLD-

BOOT)
Disk Format > Format the attached hard disk drive.
OTG Port Mode > Select mode of OTG port (the USB port comes with Y-cable). The

OTG port can be configured as “Host” (normal USB port) or “UMS”
(flash drive can be accessible by PC) or “Debug” (Can be used
Android debug mode).

Set Factory Default > Reset the internal data to original one from factory. It will reset
the TV output resolution, internal settings and database. It will
preserve the application you installed, though.
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18.2 Audio and Visual
/

4

AUDIO and VISUAL Video Output HDMI

Resolution

Native Frame Rate

Audio Output

Dynamic Range Control
Brightness
Contrast

Hue

| Video Output
PAGE 1/1

Video Output > Select video output port.

Resolution > Select resolution of the video output.

Native Frame Rate - Turn On/Off of original frame rate of the source
Cinema Original (24p) 2 Enable/ Disable cinema frame rate

TV Original (1080i 60Hz) > Enable/ Disable TV frame rate.

Audio Output > Select audio output port and format
Analog (PCM) > Audio will output as decoded PCM data
Digital 2> Audio will output as raw data

For HDMI “Digital”, the format of audio can be On/Off for each format.

' HDMI

AC3

DTS
HD-Audio

[Configuration for each format]

X In “Digital (Compressed)” output mode, each format (AC3/ DTS/ AAC/ HD-Audio)
can be configured as On/Off independently. It's because the capability of connected
audio device is quite different.

Dynamic Range Control > Controlling dynamic range or not for audio

Brightness, Contrast, Hue > Control each video parameter value
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Subtitle Language nglish (United Statr P

Subtitle Setting
Resume

Instant Skip Interval
Blu-ray RegionCode
Device Type

Sort Type

Order Type

Movie Scraper
| Subtitle Language

Subtitle Language > Select subtitle language.
Subtitle Setting > Select size, position, font, color of subtitle. Please refer 10.10.
Resume > Select resume screen pop-up method. “On” - Automatic resume

without asking. “Off” - Always startup without resuming. Pop-up
-> Pop window up to ask resume or not.

Instant Skip Interval > Select instant skip interval. Instant skip will occur when pressing
<UP> or <DOWN> key at movie playback.

Sort Type > Select sorting type of movie.
Order Type > Select ordering type of movie browser.
Movie Scraper > Select movie scraping data base.

The next page contains more configurations for movie.

Poster Layout
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Poster layout and Poster Shape - Please refer to chapter 15.

Advanced setting contains more special settings for movie.

Advanced Setting

Blue Button Mode 4 3D Mode Change »
Show Playback Infor.. On
Continuous Movie PI.. On

PAGE 1/1

Blue Button Mode >  Blue color button on remote can be configured “3D mode change”
button or “Repeat mode” button.

Show Playback Information -  Turn on/off the information window when movie start-
up.
Continuous Movie Playback -  Turn on/off successive movie playback, if any.

18.4 Music

MUSIC Instant Skip Interval
Lyrics Mode
Device Type
Sort Type
Order Type
Album Jacket Layout

Album Jacket Shape

Instant Skip Interval

Instant Skip Interval >  Select instant skip interval. Instant skip will occur when pressing
<UP> or <DOWN> key at movie playback.

Lyric Mode »> Turn on/ off or automatic if lyrics are available
Sort Type > Select sorting type of music.
Order Type > Select ordering type of music browser.

Album Jacket Layout & Shape - Please refer to chapter 15.
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18.5 Photo

Photo Layout

Transition Effect >
Slideshow Interval >
Slideshow Mode >
Sort Type >

Order Type »>

/A Lr ) g

Transition Effect

Slideshow Interval

Sort Type

Order Type

Select transition effects of slideshow.
Select transition interval of slideshow.
Select showing order of slideshow.
Select sorting type of photos.

Select ordering type of photos.

Photo Frame Layout & Shape > Please refer to chapter 15.

Wallpaper Mode >

Restore wallpaper >

Transition Effect

Off
Fade

Zoom + Fade
Panning + Fade

Transition Effect

Keep the aspect ratio or stretching to “Fullscreen”

Restore default wallpaper if background was changed.
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18.6 Network

NETWORK Wi-Fi Connection

Wi-Fi Setting

Network Server Connection
DLNA
YouTube Cache Size

Network Information

Wi-Fi Connection

PAGE 1/1

Wi-Fi Connection > Turn On/Off the Wi-Fi connection

Wi-Fi Setting > Select Wi-Fi Access Point and configure the SSID and password
Network Server ... > Please see chapter 20 and 20.1.5 for configuration

DLNA > Turn On/Off the DLNA. See chapter 21 for usage of DLNA.

YouTube Cache Size >  Determine the cache size for YouTube real-time streaming.

Network Information =  Show current connected network information.

18.7 Cover-View

Home Browse
COVERVIEW J
Movie Browser
Music Browser

Photo Browser

Settings Browser

Transition Time

| Home Browser

This page only shows the current setting of Cover-View style of each browser. You cannot
change the style in this model.
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Connecting Network Server or NAS

This device provides powerful network browsing and connection capability from Rev 1.12
firmware. This includes multiple mountings of network drives for both SAMBA and NFS. The

high performance NFS server software for PC, the TizzNFS will be also provided thru
TizzBird WEB-site

19.1 Network connection using NFS

The NFS (Network File System) is a simple but powerful networking file system originally
created by Sun Microsystems™. The NFS enables high performance file sharing between
network devices, so it's most suitable for multimedia file playback via network.

The following section explains how to connect the shared PC folders using NFS server
application or NAS (Network Attached Storage) which runs NFS server.

19.1.1 Downloading TizzNFS Server

Please download the “TizzNFS” server at Internet at the PC. Please visit our WEB-site
(http://www.tizzbird.com) to download the TizzNFS program. Please install it after
downloading it. The TizzNFS has following features.

® Runs on Windows™ XP/ Vista/ 7 (both 32 bit and 64bit)

Simple and intuitive user interface.

Enables sharing multiple folders thru EXPORT function.
Reliable and high performance operation

Simple or complex EXPORT name can be selectable.

Supports NFS2 and NFS3 protocol completely.

19.1.2 Executing TizzNFS Server & Configuration
¢

Execute the TizzNFS. The TizzNFS icon — il appear on Task Bar. Click the icon and
select “Settings” menu item.

TizzNFS at 192.168.2.8

Mo | Folder E wport Mame
TizzMF501
2 E:\Streamdownloads TizzMF502
Iv Fixed Export Name ar Cancel
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Please press button to share the folder. The folder selecting dialog box will appear
so the wanted folder can be selected.

Please repeat this procedure to select all other desirable folders to share. Please press

—l button to unselect the folder, after clicking the row of unwanted folder at the
dialog box.

The balloon help will pop-up when pressing OK button like below picture.

i TizzNFS ? X
Start Server at 192 16828

|
a

The TizzNFS will automatically run whenever log-on the PC, so shared folders will be
maintained.

19.1.3 Downloading other NFS Server

Please download the “freeNFS” or “Allegro” NFS server at Internet at the PC. The “freeNFS”
and “Allegro” NFS server was confirmed by TizzBird.

The “freeNFS” software can be downloadable at following URL:

http://sourceforge.net/projects/freenfs/files/FreeNFS.exe/download

FreeNFS can be executed without specific installation.

19.1.4 Executing freeNFS Server & Configuration

Execute the freeNFS. The freeNFS icon will appear on Task Bar. Right mouse click the icon
and select “Settings” menu item.

FreeNFS Settings FreeNFS Settings
Server |Elients| Filenamesl Serverl Clients Filenames
Fioat Folder Encoding

Fath: Codepage:

e Shream ER001 [UTF-2]
This folder will be shared wia MFS. Mounted folders Filenames will be encoded by this Codepage. Use
will be handled relative to this folder, the same codepage while mounting.

Ok I Cancel | Ok, I Cancel

Please enter shared folder name at “Path” of “Server” Tab like above picture.

Please make sure that selecting “"65001 (UTF-8)” at the “Codepage” of “Filennames” Tab.
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19.1.5 Connecting NFS Server at Device

Select <Settings Browser - Network > Network Server Connection”. This will bring the
following dialog box.
H

Network Server Connection

Network #1 [ NFS, Connected ]
Network #2 [ Connecting ]
Network #3 [ Connecting ]
Network #4 [ Disconnected ]

PAGE 1/1

Up to 4 network servers can be connected at this version, and the number of connectable
server will be increased at next version.

Please select one of the network drive number then press OK. This will bring the following
dialog box.

Network #1

v NFS

Samba
Off

Please choose NFS. This will start the SERVER BROWSING dialog box and start browsing
of available NFS server at the local network.

Ll B B 1 T IF W W B ¥ 3
Network #1-NFS

KR-PC-006 (192.168.0.2)
192.168.0.4
+ KR-PC-106 (192.168.0.11)

+ KR-PC-106 (192.168.0.28)

Refresh NFS server list
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The available NFS servers will appear with names or IP addresses. The “+” sign on the left
side of server name means it has exported folders. There can be no “+" sign server which is
not exporting the EXPORT NAMES.

If PC runs Windows OS, the PC name can also appear like above picture. If the wanted
server list is not appeared, please try RED button on remote to refresh the NFS server list.

Please select one of the server then press OK, the exported folders will appear like below
picture. Please select one of those then press OK to connect.

- . T - - - & x ¥

Network #1-NFS

KR-PC-006 (192.168.0.2)
192.168.0.4
- KR-PC-106 (192.168.0.11)
\TizzNFS01 Network #1
+ KR-PC-106 (192.168.0.28)

Refresh NFS server list

The following dialog will appear shortly and connection will be made.

Caution:

Please use RealTEK RTL8188 Wi-Fi module for NFS thru Wi-Fi. The Ralink RT3070 Wi-Fi
driver has some problem with NFS connection. The NFS + Ethernet configuration also does
not have problem.
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19.2 Network Connection using Samba

The following section explains how to connect the shared PC folders or NAS (Network
Attached Storage) which runs Samba Server.

19.2.1 Activating PC Share

- Click right mouse button on the folder which will be shared. Select “Property” then
“Sharing” TAB on the dialog box.

General | Shaing | Security | Customize

— ‘You can share this folder with other users on your
[=* network. Toenable sharing for this folder. click Share this
folder

O Do not share this folder
®F :

e

Columns

Shate name:
Comment:
User limit (® Maximum allowed

-~
-

To zet permissions for users who access this Permissions
folder over the network, click Permissions

To configure settings for offine access, click [ Caching I
Caching.

(@) Allow thiz number of ugers;

[ oK H Cancel H Apply I

- Select “Share this folder” button on the dialog box

- The shared folder can be notified at file explorer, since the shared icon will appear on
the left side of folder icon.

i s 'l ===

19.2.2 Connecting Samba Server at Device

Select <Settings Browser > Network > Network Server Connection >
F

Network Server Connection

Network #1 [ NFS, Connected ]
Network #2 [ Connecting ]

Network #3 [ Connecting ]
Network #4 [ Disconnected ]

PAGE 1/1
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Select “"Samba” at dialog box.

Network #2

NFS

v Samba
Off

This will bring the SAMBA BROWSING dialog box like below. If the wanted SAMBA SERVER
name is not appeared, please press RED button on remote.
ol 8 BB & 3 = i i | I F g

Network #2-Samba

| + KR-PC-006 (192.168.0.2)
)

The SAMBA server list will appear according to the PC-names or IP address. The “+” sign
means it has several shared folders. Press OK button to unfold the server folder list, then
select one of the folder to connect.

Network #2-Samba

KR-PC-006 (192.168.0.2)
\Data00
\dvd

\STREAMO1
\STREAMO2
\STREAMO3
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If the selected folder requires ACCESS RIGHT to connect it, the following dialog box will
pop-up to enter the log-in account information.

KR-PC-006 (192.168.0.2/STREAMO1)

User name |

Password
Show password

Remember account

Connect Cancel

Input the “User name” and “Password” using virtual keyboard. Please check “Remember
account” checkbox to by-pass this log-in procedure at next connection.

The connection will be made after pressing “Connect” button.

19.3 Accessing Network Drive at File/ Media Browser

The shared folder connected thru can be accessible at <Movie/ Music/ Photo/ File Browser
>. The below picture shows the selecting the NETWORK DRIVE at <File Browser>. Press
<RED color> button on remote at File Browser to select the network drive. Select the
network icon like following picture.

The shared folder will appeared and the files and folders can be browsed or playback.
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20 Using DLNA

Tizzbird fully implements several DLNA stacks includes DMP (Digital Media Player), DMS
(Digital Media Server) and DMR (Digital Media Renderer). It can be used very flexibly
several ways.

DMP (Digital Media Player)

TizzBird can browse other DMS (Digital Media Server) servers including DLNA enabled PC,
Smart Phone and NAS, and be able to playback the contents on the designated server.

DMR (Digital Media Renderer)

TizzBird can render (decode & do presentation) the contents which were designated by
DMC (Digital Media Controller). For example, SMART PHONE can be used for browsing and
controlling the contents on the DMS and designate the contents should playback on TizzBird
output. So you can see the movie, photo and listen to the music on the SMART PHONE or
DLNA server.

The beauty of this DMR is browsing can be done intuitively by smart phone, and output may
appear on big screen TV. So user can enjoy the contents on several screens (so called N-
screen) by designating the rendering output to any DMR device.

DMS (Digital Media Server)

TizzBird can be a DLNA server, so other DLNA device including SMART PHONE can browse
and start playback the contents on the TizzBird.

So combined overall DLNA stacks, the mutual contents sharing between TizzBird and other
device (TAB, SMART PHONE, PC) is quite easy and intuitive.

The most important DLNA stack here can be DMR. Because SMART PHONE or TABLET
can be used as controller (DMC) and playback can be done on TizzBird. So users can easily
browse contents on server or their phones, and see the contents on BIG SCREEN TV.
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Preparation for DMR

v' Preparing TizzBird & Access-Point

Prepare TizzBird F12 or N1 for demonstrating DMR with Rev 2.90 or later firmware.
Connect the Wi-Fi or Ethernet with prepared Access-Point.

® Enable the DLNA at “Settings Browser - Network - DLNA"

v' Preparing Smart Phone.

Prepare Android Smart Phone (Gingerbread or later) or iPhone and connect the
same Access-Point as Tizzbird connected.

® Download the iMediaShare or Twonky app from the market.

v' Preparing DLNA Server (Optional)
If you have a plan to browse or playback DMS using PC, please prepare like this.

Download the latest Windows Media Player for DLNA server.
Or download the Twonky Server on PC for DLNA server.
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20.2 Sending Smartphone’s Contents - iMediaShare APP

iMediaShare is a good example of DMC, DMS and connects contents to DMR. It has several
on-line-site DLNA server examples, which are very good to demonstrate, and some of them
are in High-Definition. iMediaShare is also available on iPhone.

v' Execute the iMediaShare APP

The iMediaShare startup screen will come up like below.

Loading video channels

experience
personal TV

@ Bianor, 2010-2012

v' Select the online site example

Select one of the on-line site examples. Below screen shows some candidates.

:--n-“' Beet“én HIM“E

CBS
(—

© -
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"My Photos”, "My Music”, "My Videos” show local contents on your phones. Below
screen shows the “Victoria’s Secret” on-line DLNA server. Click one of the contents.

Victoria's Secret

ilMediaShare

REUTERS

ONtiNe SCYWTIME TE%

06:36

VSX Sport Presents the Sexiest
Workout Ever: Butt

23 days ago 0%:53

VSX Sport Presents the Sexiest

A month ago 06:58

VSX Sport Presents the Sexiest

v' Select the final renderer.

If you click one of the contents, and TizzBird settings are correct, the "RENDERER"”
selection pane will pop-up. Select "TizzBird DLNA Renderer”.

VSX Sport Presents The Sexiest
Workout Ever: Outtakes

v" Demonstrating Smart Phone local contents to Tizzbird
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- Select the contents on the SMART PHONE.

Select "My Videos” on the menu. Then following screen will pop-up

ilMediaShare My Videos

@ @ Shakira-Loca (David Letterman
" . . “‘ 09-23-2010).avi

il — W
:""‘S

A SN n-
Audi +r Beet,i\é HIM.“E

BE HD

CBS :
F—

O - avome.__ Alvies

Select one of the movies you want to playback and Tizzbird will start playback. It's so-
called DMR (Digital Media Renderer).
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20.3 Sending Smartphone’s Contents - TWONKY APP

Twonky is a powerful DLNA app which let you browse overall DLNA server on your local
network. It also provides playback controller which is very stable.

v" Run Twonky

A

Connecting To Your Media

v' Select categories of contents that you want to playback. Then select one of the

contents
Media Sharing Media Sharing
Connected to Wi-Fi network: Connected to Wi-Fi network

nzzetsofilin tizzetsof11n

Set the midia types (ha yow would ke o share on th Set the medio types that you would ke fo share an this
PeErwirk network

Music e Music o
Photos o Photos o
Videos 0 Videos o
Remember this network 9 Remember this network @

Done Daone
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v' Designate the renderer. Then the Tizzbird will start playback.

Beam to:
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21 Firmware Upgrade
21.1 Online Upgrade (O.T.A — Over the Air Upgrade)

TizzBird will connect the firmware update server periodically (once a week) and pop-up
upgrade prompt window automatically, if new firmware is available. If TizzBird is connected
to the network, the upgrade can be performed as following.

1) Prompt the firmware if new version is available.
2) Select <SETTING BROWSER> > <SYTSTEM> - <FIRMWARE UPDATE>
3) Setting browser will can the new firmware available on network and pop-up the window.

4) Press <OK> to start upgrade.

—_—

= i anguage
SYSTEM . Language

Firmware Update

,’? -H'.'.\i".-.g_ |
- mgoy S
@’ ?g ystem

PAGE 1/1 b

\ - Out
- v ; ScreenSaver Mode

Auto Power Off Time

Screen Resize
| Firmware Update
PAGE 1/2

21.2 Local Upgrade

Separately downloaded firmware (thru PC) can be upgraded like below. The upgrade will
not take more than 1 minute.

21.2.1 Upgrade at Settings Screen

Copy or move the latest firmware to the root folder of USB flash or HDD drive.

- Connect the drive to USB port of the unit.

- Select <SETTING BROWSER> - <SYSTEM> - <FIRMWARE UPDATE>.

- SETTINGS BROWSER will scan the new firmware automatically and pop-up the window.
- Press <OK> button to start upgrade.
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Copy or move the latest firmware to the root folder of USB flash or HDD drive.

/A

21.2.2 Upgrade at File Browser

Connect the drive to USB port of the unit.
Select <FILLE BROWSER> at HOME SCREEN. .

Browse the firmware file and press <OK> to start upgrade.

use1
[Current folder]

APKs
ChineseAndroidGame
Fonts

Install

Localization

o |

Lo}
=)
=]
=
=
=]
=il

PAGE

FILE LIST
TizzBird_F3x_update V0_99 _11071916.tzbird
» - TizzBlrd_F3x_update_V0_99_11072116.tzbird
TizzBird_F3x_update_V0_99_11072121.tzbird
. TizzBird_F3x_update_V0_99_11072200.tzbird
= - TizzBird_F3x_update V0_99_11072213.tzbird
= © TizzBird_F3x_update V0 99 11072221.tzbird
% home_background.bmp
57 home_background.jpg

DATE Y PAGE

76




22

TIZZBIRD - SMART MEDIA PLAYER

Using N1 as a Mass Storage

TizzBird N1 contains T-flash memory which is mainly used for Android system image and
working area. Some part of T-flash area is assigned to SD-card area which is used by
Android system as an external memory. This SD-card area can be accessible by PC as a USB
mass storage device (UMS). So if you have 8G/ 16G/ 32GB version of TizzBird N1, you can
use more extra SD card area for storing various multimedia contents.

Here's the procedure to access. Before do that, please prepare normal micro-USB cable
to connect PC. The micro-USB cable is normal type that can connect SMART PHONE with PC
USB port.

1) Connect N1 to TV and turn it on.

2) Select <SETTING BROWSER> > <SYTSTEM> - Page2 <Advanced Setting> > OTG
Port Mode

3) Select “External Storage (UMS)” to connect PC.

e A o _ 2 TY W - . N
Advanced Setting

Devicel OTG Port Mode

Scanni
Power
Disk F¢
OTG P¢
Set Fa(

External Storage (UMS)
v Host
Debug

| Advanced Setting

4) Turn off the power of N1.
5) Connect PC with micro-USB cable you prepared.

6) The N1 will power-on and work as a MASS STORAGE DEVICE. You can freely access the
N1's storage area including reading, writing & erasing.

7) After done, please restore the <OTG Port Mode> to “Host” when connect the N1
back to TV. Otherwise, the SD card area will not be accessible by Android system of N1.
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